
Registered Office : Aphena Ltd., 10, Teversham Road, Fulbourn, Cambridge, CB1 5EB 
Registered in England and Wales: No 04744781.  VAT No GB 817 8776 77 

 

 
 

+Plus+
 

 

 

Measurement  
Management Software 



 

SoftPlot
+Plus+

 
Measurement Management Software 

 

Contents 
Introduction................................................................................. 2 
Program Installation.............................................................. 3 

1. Hardware Requirements .................................................................................. 3 
2. Software Installation........................................................................................ 3 
3. Further Information......................................................................................... 5 

Getting Started with SoftPlot ........................................................ 6 
1. Capturing Traces ............................................................................................. 6 
2. Displaying Traces with the Graph Screen ....................................................... 8 
3. Saving Measurements ...................................................................................... 8 
4. Inserting SoftPlot measurements into other applications ................................ 8 

4.1. Starting from within SoftPlot.................................................................................. 8 
4.2. Starting from another program .............................................................................. 9 
4.3. Editing SoftPlot measurement objects .................................................................. 9 

Software Licence Agreement .......................................................... 10 
1. Terms of Licence ............................................................................................ 10 
2. Licence ........................................................................................................... 10 
3. Permission to copy Licensed Programs......................................................... 10 
4. Protection and Security ................................................................................. 10 
5. Termination.................................................................................................... 10 

Limited Warranty............................................................................ 11 
Governing Law and General Provisions........................................ 11 



 2

Introduction 
SoftPlot is designed for putting quality measurement plots into word 
processor documents and presentation packages.  Many instruments, such 
as spectrum analyzers and network analyzers, have the capability to 
generate a hard copy of the measurements by connecting a suitable pen-
plotter to their GPIB interface.  SoftPlot improves on this by using the GPIB 
to extract only the unformatted data from the instrument and allowing it to 
be manipulated in a number of ways.  For example, the graticule type, style 
and scaling can be re-defined, and markers and limit lines added.  In 
addition, the graph can be annotated in various ways, and if there are 
several traces they can be drawn in different pen styles and colours. 

The resulting measurement is packaged by SoftPlot in a way that can be 
electronically pasted into a word processor document (or slide presentation, 
etc.).  This makes use of the Object Linking and Embedding (OLE) feature of 
Windows applications. 

When an embedded or linked SoftPlot object in a document is double-
clicked, SoftPlot will be started and the measurement data displayed for 
editing.  These changes are automatically reflected in the destination 
document when SoftPlot is closed. 

A wide range of file formats are handled to allow the import and export of 
measurement data to other software such as Microwave Office (TM AWR), 
ADS (TM Agilent), spreadsheets or maths packages.  With SoftPlot, the 
information previously locked up in your hardcopy result is now accessible 
long after the measurement was done. 
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Program Installation 

1. Hardware Requirements 

The minimum system requirements in order to run the software are : 

1. Pentium® PC, 200MHz, 64MB RAM, 200MB available disk space. 
2. Microsoft® Windows® XP, Vista, 2000, NT4®, ME, or 98. 
3. If instrument transfers are required: 
a National Instruments (www.ni.com) GPIB card, type PC-IIA, PC-AT, PC-

PCI, PC-PCMCIA, PC-USB-A/B/HS; 
or a Measurement Computing (www.computerboards.com) GPIB card, 

type ISA-GPIB, ISA-GPIB/LC, ISA-GPIB-PC2A, PCI-GPIB, PCM-GPIB; 
or an Agilent / Hewlett-Packard (www.agilent.com) 82335, 82340/82341, 

82350 or 82357 HP-IB card 
or an ines (www.inesinc.com) GPIB-PCMCIA, GPIB-PCI card 
or an IC Select inc. (www.icselect.com) 488-USB, 488-USB2. 

Other GPIB cards with a National Instruments - compatible GPIB-32.DLL 
driver providing the same programming interface may work, but have not 
been tested. 

2. Software Installation 

1) If a GPIB card is to be used, this should be installed first.  Follow the 
manufacturer's  documentation and use the installation program provided 
with the card.  For National Instruments cards, it is only necessary to install 
the Windows GPIB-32.DLL driver. For Agilent cards, it is only necessary to 
install the Agilent SICL32.DLL driver. 

NOTE the selection between National Instruments and Agilent cards is 
selected once SoftPlot is running. Choose GPIB Card Configuration from 
the Edit menu, and select the type of card to be used. The default is National 
Instruments. 

2) The installation of SoftPlot is automated by running the installation 
program on the distribution disk. You will be prompted to choose the name 
of a new top-level folder, which will be created to keep the program and 
other files. C:\Program Files\SoftPlot-7\ is the default, but you may 
change this.  The following files will be transferred into your chosen folder: 
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•  SOFTPLOT.EXE the main program 
•  SOFTPLOT.INI configuration parameters for  
 the main program 
•  SOFTPLOT.HLP the help system 
•  TOURGUID.HLP guided tour help file 
•  SAMPLES\ A number of samples files will be 

 copied to this directory 
•  TEMPLATE\ sample measurement templates 

A new program group and icon will be created by the install program 
before it closes. 

3) Registration of the product is required before the program will run. The 
first time it is started after installation, the registration dialog box will be 
displayed. Your Name, Company and Email Address will be used to contact 
you in relation to this software. In the case of customers who have 
purchased Annual Maintenance, update and renewal information will be 
sent to this email address. On the distribution disk you will find the Product 
Password.  

If you have an Internet connection available, registration occurs 
immediately you click on the OK button. If your Internet connection is via a 
proxy server, this may be configured at the bottom of the dialog box.  

If you don’t have an Internet connection, complete the form first, and then 
you must select the option No Internet Connection Available. Then click on the 
Save Registration Details button to save a file that you can attach to an email 
to “registrations@aphena.com”. When you receive an authorisation file from 
Aphena, you can load it using the Load Authorisation File button and click 
OK to continue. This will reload the form data again, so it is permissible for 
you to cancel and close the registration form until you have received the 
authorisation file. 

The number of installations allowed using a given Product Password is 
controlled. This limit is determined by the details of licence that has been 
purchased. After a successful registration, the remaining number of 
installations available will be displayed in a message box.  

4) Running SoftPlot will cause it to register itself as an OLE server in the 
system registration database.  If SoftPlot is moved to a different drive or 
directory, or has been upgraded, it will automatically modify the 
registration details when it is next run. 
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5) To uninstall SoftPlot, click on Add/Remove Programs in the Windows 
control panel. If an Internet connection is available at the time of 
uninstallation, an automatic unregistration occurs and the available number 
of installations for the associated Product Password is increased. 

6) Fonts required: 

1. "MS Sans Serif" 
2. "Arial" 
3. "Arial Narrow" 

"Arial Narrow" is distributed on the installation disk and is automatically 
installed if required.  The other fonts come with Windows as standard. 

3. Further Information 

SoftPlot was written by and is copyright of Aphena Ltd..  For further 
information, contact 

Aphena Ltd., 
10, Teversham Road, 
Fulbourn, 
Cambridge, 
United Kingdom 
CB1 5EB. 
E-mail: support@Aphena.com 
Web Site: http://www.Aphena.com 
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Getting Started with SoftPlot  

You can start SoftPlot from the Start button and then navigating to Progams, 
SoftPlot V7.0 and then clicking on its shortcut.  The program will briefly 
show a start-up banner and then display the main screen.  The program is 
divided into six tabbed pages, dealing with the measurement data 
presented as a Graph or a Table, and GPIB transfers from Network 
Analyzers, Spectrum Analyzers, Signal Analyzers and Oscilloscopes. 

1. Capturing Traces 

Choose the Network Analyzer, Spectrum Analyzer, Modulation Analyzer or 
Oscilloscope, according to the type of instrument you have. Scroll through 
the Instrument list and choose the name that most closely matches your 
instrument. 

GPIB: Connect up the computer to the instrument with a GPIB cable. 
Then enter its GPIB address into SoftPlot. You may need to set 
up SoftPlot to match your GPIB Card Configuration. 

 Note: to search for instruments present on the bus, click to set the 
cursor in the GPIB Address entry box, and press function key F3. 
This shows a list of bus addresses of all operational instruments 
available to SoftPlot. You may choose from the list and click OK 
to enter that address in the GPIB Address entry box. 

RS-232: Some instruments are fitted with an RS-232 port, which allows 
them to be programmed from the PC COM1: or COM2: ports. If 
you only need to connect to one instrument, and it has a suitable 
RS-232 port, you can avoid the cost of adding GPIB to your PC. 
When SoftPlot is running, choose "GPIB Card / Serial / LAN 
Configuration" from the "Edit" menu, and select "Enable Serial 
Interface". Then click on the Setup button which will have 
appeared, in order to configure the PC serial port settings. 

LAN: LAN connections are available on some newer instruments, and 
SoftPlot has support for this using Socket Services. On the 
appropriate instrument transfer page, select LAN (just above the 
Start Transfer button), and enter the IP address of the 
instrument. 
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VISA: VISA, or Virtual Instrument Software Architecture is an 
interface-independent software interface endorsed by the 
VXIplug&play Systems Alliance. This allows connection to 
instruments that contain a VISA server (also referred to as a VXI-
11 server), and this permits GPIB, TCPIP, Serial and USB 
connections. 

 In C:\program files\softplot-7\lan utils you will find 
SktClient.exe, which can be used to help establish basic 
communication between the PC and the instrument. Enter 
simple SCPI commands such at "*IDN?" to establish that the 
network link is working. 

 NOTE: The Agilent PNA series of network analyzers have a 
network connection but do not implement Socket Services. Copy 
C:\program files\softplot-7\lan utils\ PNASocketSvr.exe to 
your instrument and run it on the PNA's PC to implement the 
required socket services functionality. 

 

Generally, SoftPlot is programmed to extract the live, updating trace on the 
screen of the instrument.  On some instruments with more than one 
simultaneous channel, the Measurement Data selection box allows you to 
specify which channel to transfer. 

Now choose the destination of the transfer.  There are 100 trace data stores 
arranged in a 10 x 10 grid.  The ordering of the grid is important for network 
analyzer transfers when the stores are used to represent an S-Parameter 
matrix. 

Before clicking on the Start Transfer Button, you may wish to select the 
options at the bottom of the screen, and enter a meaningful name in the 
Trace Label box - this is used as the default trace label when the trace is 
added to the graph later. 

Now click on the Start Transfer button.  If all is well, the data transfer 
progress should be observable in the status line at the bottom of the screen.  
If an error occurs, see GPIB Transfer Troubleshooting in the on-line help 
documentation. 
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2. Displaying Traces with the Graph Screen 

The Graph Screen is used to present the measurement data in a similar form 
to the hardcopy produced by the instrument directly on a plotter.  A 
number of graticule types and styles are available.  The 100 data stores can 
be viewed in any combination as up to 100 separate traces, formatted 
differently and assigned to either the left or right vertical axis.  Each vertical 
axis has an independent scale and display format.  There are independent 
X-axes and a primary common x-axis for all the data stores and traces.. 

3. Saving Measurements 

Measurement data is saved in SoftPlot files (*.SPT) using the Save and Save 
As menu functions.  This file format stores all measurements (whether 
displayed or not), and all other graph display settings. 

It is also possible to Export files in Touchstone SxP format, spreadsheet 
(*.CSV), tab - delimited (*.TXT), Citifile (*.D) and MathCad (*.PRN) file 
formats, as well as a range of graphics formats (BMP, TIF, JPG, WMF).. 

4. Inserting SoftPlot measurements into other applications 

SoftPlot uses Object Linking and Embedding (OLE) to allow you to either 
embed the entire measurement and its data within a report or presentation, 
or alternatively to insert the graph with a link back to the SoftPlot file.  Your 
starting point can be either from SoftPlot or from your word processor or 
presentation package. 

4.1. Starting from within SoftPlot 

The simplest method is to start SoftPlot with the required measurement 
displayed, and to embed it in the destination document. 

a) Right-click on the graph and choose Copy OLE Object, or select Copy 
SoftPlot OLE Object from the Edit menu 

b) Switch to the word processor package and paste it in.  To create a link to 
the original SoftPlot file rather than to embed a copy of it, choose Paste 
Special rather than Paste, and then select Link to File (or Paste Link). 
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4.2. Starting from another program 

If you are drafting a report or creating a slide presentation, and you want to 
pull in a SoftPlot measurement, you can do so in the following way: 

a) Go to the place where you want the graph to appear.  Choose Insert 
Object from the Insert or Edit menu.  Select "SoftPlot Measurement" 
from the list of available objects and click on the "OK" button.  This will 
run SoftPlot in embedding mode, which alters some of the menus. 

b) Then use SoftPlot to transfer the measurement from your equipment, or 
Import an existing file. 

c) Choose Exit and Return to filename from the File Menu, and you will 
return to a new graph in your document. 

To create a link to an existing file, use the Create from File option after 
selecting Insert Object. 

4.3. Editing SoftPlot measurement objects 

After inserting your SoftPlot measurement into a document, it is possible to 
alter it, simply by double - clicking on the graph.  This will cause SoftPlot to 
run and automatically load the embedded measurement data or the linked 
file, ready for editing.  Choose Exit and Return to filename from the File 
Menu, and you will return to an updated graph in your document. 
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Software Licence Agreement 
This software is protected by both UK copyright law and international copyright 
provisions.  Aphena Limited hereinafter referred to as Aphena agree to grant, and 
the user agrees to accept on the following terms and conditions, a non-transferable 
and non-exclusive Licence to use this software. 

1. Terms of Licence 
The agreement is effective from the date of receipt by the User of the above 
referenced Software and the User's acceptance of the terms and conditions by 
loading the Software into any Computer. 

2. Licence 
This single licence permits only a single instance of the software to be used at any 
time.  It may be used by any number of people, and may be freely moved from one 
computer location to another, so long as there is no possibility of it being used 
simultaneously at more than one location or simultaneously by more than one user. 
A single licence may be installed on a maximum of three computers at any time. 

3. Permission to copy Licensed Programs 
(i) The software may be copied onto a computer to be used and archival copies may 
be made for backup purposes only. 

(ii) The User shall NOT modify, adapt, merge, translate, reverse engineer, 
decompile, disassemble or create derivative works based on whole or any part of 
the Software or its associated documentation. 

4. Protection and Security 
The User agrees not to provide or otherwise make available any Licensed Software 
to any person other than his employees and/or agents without prior written consent 
from Aphena. 

5. Termination 
Within one month of the termination of the Licence under this Agreement, the User 
will furnish Aphena a letter verifying that through his best efforts, and to the best of 
his knowledge, the original and copies in whole or part, in any form, including 
partial copies of the Licensed Software received or made in connection with such 
Licence have been destroyed. 
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Limited Warranty 
Aphena Limited warrants the physical diskette(s) and physical documentation 
enclosed herein to be free of defects in materials and workmanship for a period of 
sixty days from the purchase date.  If Aphena receives notification within the 
warranty period of defects in materials or workmanship, and such notification is 
determined by Aphena to be correct, Aphena will replace the defective diskette(s) or 
documentation. 

The entire and exclusive liability and remedy for breach of this Limited Warranty 
shall be limited to replacement of defective diskette(s) or documentation and shall 
not include or extend to any claim for or right to recover any other damages, 
including but not limited to, loss of profit, data, or use of the software, or special, 
incidental, or consequential damages or similar claims, even if Aphena has been 
specifically advised of the possibility of such damages.  In no event will Aphena's 
liability for any damages to you or any other person ever exceed the lower of the 
suggested list price or actual price paid for the licence to use the software, 
regardless of any form of the claim. 

Aphena Limited specifically disclaims all other warranties, express or implied, 
including but not limited to, any implied warranty of merchantability or fitness for a 
particular purpose.  Specifically, Aphena makes no representation or warranty that 
the software is fit for any particular purpose and any implied warranty of 
merchantability is limited to the sixty - day duration of the Limited Warranty 
covering the physical diskette(s) and physical documentation only (and not the 
software) and is otherwise expressly and specifically disclaimed. 

This limited warranty gives you specific legal rights which are in addition to your 
statutory rights as a consumer. 

Governing Law and General Provisions 
This licence agreement shall be construed, interpreted and governed by English 
Law.  If any provision of this agreement is found void or unenforceable, it will not 
affect the validity of the balance of this agreement, which shall remain valid and 
enforceable according to its terms.  If any remedy provided is determined to have 
failed its essential purpose, all limitations of liability and exclusion of damages set 
forth in the Limited Warranty shall remain in full force and effect.  This agreement 
may only be modified in writing signed by you and an authorised officer of 
Aphena.  All rights not specifically granted in this agreement are reserved by 
Aphena. 


